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Abstract

With the realization that mechanical forces mediate many biological processes and contribute to 

disease progression, researchers are focusing on developing new methods to understand the role of 

mechanotransduction in biological systems. Despite recent advances in stretching devices that 

analyze the effects of mechanical strain in vitro, there are still possibilities to develop new 

equipment. For example, many of these devices tend be expensive, whereas few have been 

designed to assess the effects of mechanical strain driven by the extracellular matrix (ECM) to 

epithelial cell monolayers and to cell-cell adhesion. In this chapter, we introduce a cost-efficient, 

user-friendly, 3D-printed stretching device that can be used to test the effects of mechanical strain 

on cultured epithelial cells. Evaluation of the device using speckle-tracking shows homogeneous 

strain distribution along the horizontal plane of membranes at 2.5% and 5% strains, supporting the 

reliability of the device. Since cell-cell junctions are mechanosensitive protein complexes, we 

hereby used this device to examine effects on cell-cell adhesion. For this, we used colon epithelial 

Caco2 cell monolayers that well-differentiate in culture and form mature adherens junctions. 

Subjecting Caco2 cells to 2.5% and 5% strain using our device resulted in significant reduction in 

the localization of the core adherens junction component E-cadherin at areas of cell-cell contact 

and its increased translocation to the cytoplasm, which in agreement with other methodologies 

showing that increased ECM-driven strain negatively affects cell-cell adhesion. In summary, we 

here present a new, cost-effective, homemade device that can be reliably used to examine effects of 

mechanical strain on epithelial cell monolayers and cell-cell adhesion, in vitro.
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1 Introduction

Mechanical forces are crucial in numerous biological processes. Mechanical stimuli are 

converted into biochemical signals through signaling pathways that ultimately drive 

processes such as development and wound healing [1, 2]. Research in recent years has been 

focused on mechanical stress as a catalyst to disease, including tumor progression [3, 4]. For 

example, fibrosis, characterized by the excessive accumulation of extracellular matrix 

(ECM), is a major precursor to cancer [5, 6]. During fibrosis, ECM undergoes extensive 

remodeling, thereby introducing atypical physical conditions such as high stiffness and 

increased physical strain [3, 4], which alter biomechanical signaling and promote abnormal 
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cell behavior [7-11]. Strain, defined as deformation due to stress [12, 13], is a major mode 

where cells experience mechanical stress via physical forces such as compaction and tension 

[14]. Therefore, the development of methodologies that allow the studying of mechanical 

regulation of biological processes has been an emerging field. A simple method to model 

cell deforming and its effects on cell signaling and behavior is by stretching cells, in vitro 

[3].

A number of commercially available or homemade stretching apparatuses that are either 

computer assisted or manually controlled have been developed. These devices can apply 

steady or cyclic stretch either uniaxially or biaxially over a predetermined duration [15-18]. 

Although computer-controlled devices can be accurate and precise compared to manually 

controlled devices, they can be costly. On the other hand, homemade apparatuses are most 

cost-efficient but can be hard to replicate, or they may produce inconsistent results, without 

published detailed protocols accompanying them. Depending on the frequency, load, and 

type of stretch, results of strain experiments can be vastly varying, which also calls for well-

controlled and fully detailed published methodologies [19]. Disclosing all the characteristics 

of the stretch methodology when analyzing and comparing results is essential, especially 

when considering different studies or studies based on different protocols. Here, we 

introduce in full detail a homemade, manually controlled device that applies a steady 

uniaxial stretch over a set-time period. It is cost-efficient, easy to assemble, and user-

friendly.

We particularly introduce this device to study cell-cell adhesion. Cell-cell and cell-

extracellular matrix (ECM) interactions are mediated by mechanosensitive complexes that 

transmit physical signals to the inner cell environment and vice versa [19-23]. Thus, there is 

growing interest on cell-cell adhesion components, such as cadherin complexes, as readouts 

to assess the effects of physical forces in cellular homeostasis [24, 25]. Furthermore, 

cumulative evidence portrays E-cadherin-based adhesion complexes as signaling epicenters 

regulating epithelial cell behavior, further underscoring their significance as 

mechanoresponsive cellular components [26-30]. E-cadherin is the epithelial-specific 

cadherin and the most abundant cadherin in the human body. However, most models 

studying mechanical strain on cells have been focused on single-cell, non-epithelial, cell 

models [31-34], rather than in epithelial monolayers, where E-cadherin expression is 

predominant and critical. For the above reasons, we focused developing this protocol for the 

study of E-cadherin-based cell-cell junctions in Caco2 colon epithelial cells [35]. Caco2 

cells are widely used as a model of the well-differentiated epithelium, and they abundantly 

express E-cadherin [36, 37]. Indeed, cyclic stretch has been previously noted to disturb cell-

cell junctions and enzymatic activity of Caco2 cells [38]. In the present protocol, we 

developed a stretching device using 3D printing and standardized it using a speckle-tracking 

method. We then used it to analyze distribution of E-cadherin under increased strain. Results 

show significant and consistent changes in E-cadherin subcellular localization under 

different conditions of strain. We anticipate that our methodology will provide a useful tool 

for the study of the effects of mechanical strain in E-cadherin-based cell-cell junction 

complexes, as well as its effects on epithelial monolayer integrity, barrier function, cellular 

signaling, and cell behavior.
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2 Materials

2.1 3D Printing

1. Material: Fromlabs Clear resin, V4 (FLGPCL04).

2. Software: PreForm, Form 2 [39].

3. 3D printing hardware: Formlabs, Form 2 Stereolithography (SLA) resin-based 3d 

printer.

4. Washing buffers: >90% Isopropyl alcohol (IPA), Form cure-Formlabs.

5. Flush cutters.

6. Dremel: 4300-9/64.

7. Taps and Dies: DWA1450.

2.2 Cell Culture

1. Caco2 cells: ATCC-HTB-37.

2. Silicone Membrane: Specialty Manufacturing, Inc. (SMImfg.com). Silicone 

Sheeting 0.010″ NRV G/G 40D 12″ × 12″. Lot number SMI8042512. 

Dimension of each strip is 2 cm × 11 cm. Membrane is cut according to the 

number of strips required.

3. 1.5 μg/cm2 Laminin: Sigma, L2020 Laminin from Engelbreth-Holm-Swarm 

murine sarcoma basement membrane. Laminin is diluted in Hank’s Balanced 

Salt Solution (HBSS): Fisher Scientific 14170-120 as required (see Note 1).

4. Cell culture medium: MEM, Fisher Scientific MT10010CV-MEM W/GLN HI 

GLU PYR was supplemented with 10% FBS, Fisher Scientific A3160502, 1 mM 

sodium pyruvate, Invitrogen 11360070-100 mM and 1× non-essential amino-acid 

supplement, Invitrogen 11140050-100X.

5. PBS: Fisher Scientific 21040CV.

6. 70% ethanol.

7. 150 cm dishes: Corning 12556003.

8. Tweezers: Millipore XX62000006P.

9. Glass Staining Dishes for 50 Slides: DWK Life Sciences Wheaton, Fisher 

Scientific 08813C.

2.3 Immunofluorescence

1. Ice cold Methanol: Fisher Scientific A4524.

2. Antibodies: Primary antibody used in the study was E-cadherin 4A2C7, Life 

Technologies 180223. Secondary antibody used in the study was Alexa Fluor 

488 anti-mouse, Life Technologies A21202, with a 1:500 dilution. Dilute both 

primary and secondary in antibody diluent: Dako S302281-2 at a 1:500 dilution.
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3. Blocking solutions: Dako X090930-2.

4. Mounting solution: Polysciences, Aqua Poly/Mount-18606.

5. Coverslips: VWR48393-106-22x60.

6. Mounting slide: Denville Science M1011.

3 Methods

3.1 3D Design and Printing of the Stretching Apparatus

1. Prototyping of the apparatus is carried out using PreForm: Form 2 software [39].

2. Stretching apparatus is printed using Fromlabs Clear resin-V4 (FLGPCL04) and 

with Formlabs: Form 2 Stereolithography (SLA) resin-based 3d printer.

3. Wash in >90% IPA for 15 min in Form Wash station.

4. Cure in Form cure for 15 min at 60 °C in Form Cure station.

5. Remove any support material with the use of flush cutters and a Dremel.

6. Clean the threads using taps and dies.

The stretching apparatus has five parts: two fasteners on the steady edge, one peg, one 

pulling clamp, and the main container. A starting point is marked in a side of the main 

container where the length from the steady edge to the starting point is 5 cm. This device is 

designed permitting the tensile strain equation shown below (Eq. 1), where ΔL is the change 

in length and L0 is the starting length [40]. Then, the ratio between ΔL and L0 is converted 

to a percentage to obtain the strain percentage (Eq. 2). Hence, at 0% strain the length of the 

membrane or L0 is 5 cm.

Tensile strain = ΔL
L0

(1)

Tensile strain percentage% = ΔL
L0

× 100 % (2)

Two fasteners are designed to keep the membrane stable and locked at the steady edge. 

Thus, the membrane does not move at this end. The uniaxial strain is applied by pulling the 

clamp via rotating the peg. The peg is marked with numbers that represent 0.1% strain. A 

complete rotation of the peg is approximately equal to 1% strain. Thus, the change in length 

or ΔL is 5 mm. Another starting point is marked on top of the container at the pulling end. 

The pulling camp has multiple grooves to keep the membrane intact while pulling. At 0% 

strain, the pulling clamp is in line with the starting point marked at the side of the main 

container, and the 0% mark on the peg is in line with the starting point marked on top of the 

main container (Fig. 1a, b).

In order to validate that the stretching platform was applying a uniform stretch field to our 

cell cultures, we used standard two-dimensional digital image correlation (DIC) techniques. 
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Briefly, culture membranes were marked by a scattered pattern of pencil shavings and 

imaged before and after 2.5% and 5% strain (Fig. 2a). Images were then fed into an open-

source, MATLAB-based DIC algorithm (Ncorr.com) [41], which automatically registers 

each deformed image to the reference (undeformed) image, identifies particle patterns, 

measures displacements of particles between deformation steps, and then calculates the full 

deformation gradient tensor (F) and resulting Engineering strains (defined as the stretch ratio 

– 1, and corresponding to the macro-scale Tensile strain from Eq. 1 above). We repeated all 

strain calculations and averaged across three replicates (Fig. 2b, c).

3.2 Cell Culture

1. Wash cut membranes and tweezers with 70% Ethanol and leave in the cell 

culture hood under UV light on for 20 min until Ethanol is dried out.

2. Switching to bright light, carefully place the membranes inside a 150 mm cell 

culture dish using tweezers (see Notes 2 and 3).

3. Cover the membrane surfaces with diluted Laminin solution [42] in HBSS as 

calculated (see Note 1) and leave in the cell culture hood for 1 h (see Notes 4 and 

5).

4. Remove the excess fluid and air dry the coated surfaces for 10 min.

5. Evenly plate 10.0 × 106 Caco2 cells using cell culture medium to 

homogeneously cover the whole 150 mm plate and leave the plate in the cell 

culture incubator at 37 °C with 5% CO2 until confluent (see Note 6).

3.3 Cell Stretching and Fixing Process

1. Autoclave the glass containers before the experiment begins.

2. Wash the disassembled stretching apparatuses with 70% ethanol and leave in the 

cell culture hood with UV light on for 20 min until Ethanol is dried out (for 

different strain conditions, different apparatuses are required).

3. Bring the confluent cell culture dish inside the cell culture hood.

4. Wash the cells with PBS once and add fresh medium.

5. Carefully place one membrane with cells at a time in each of pulling clamp of 

the apparatus using tweezers.

6. Place the pulling clamp with the membrane inside the main container and drag 

until the starting point is met by rotating the peg. It is important that the scale of 

the peg is at zero when the pulling clamp is at the starting point.

7. Lock the free end of the membrane to the steady end using the fasteners.

8. Turn the peg until the desired strain is met. For example, a 2.5 turn of the peg 

approximates to 2.5% strain, and the starting point is 0% strain.
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9. Place the apparatuses with membranes inside the glass container (two 

apparatuses can fit in one container) and fill cell culture media until the 

membranes are fully covered (approximately 100 mL).

10. Place the closed glass container inside the cell culture cell hood at 37 °C with 5% 

CO2 for 2 h.

11. After 2 h, while the apparatuses are inside the glass container, remove media and 

wash the membranes with PBS once (see Note 7).

12. Add ice cold methanol into the glass container until the membranes are fully 

covered and place the glass container at −20 °C for 8 min.

13. Remove the methanol and wash membranes three times with PBS.

14. Carefully remove membranes from the apparatuses and place in a new 150 mm 

dish with PBS (see Note 8).

3.4 Immunofluorescence Staining

1. Block the membranes with blocking reagent for 1 h at room temperature and 

stain with primary antibodies diluted in antibody diluent overnight at 4 °C (for 

processing of multiple strips see Note 9).

2. Wash three times with PBS and stain with fluorescently labeled secondary 

antibodies diluted in antibody diluent for 1 h at room temperature.

3. Wash two times with PBS, co-stain with DAPI diluted in PBS, and wash once 

again with PBS.

4. Add drops of mounting solution on to the mounting slides and place the 

membranes with cells side up.

5. Add a drop of mounting solution on top of the membrane and place coverslip on 

top.

6. Seal the edges of coverslip with nail polish and dry overnight at room 

temperature in the dark.

3.5 Imaging and Analysis

1. Image the slides using confocal microscopy – for this study a Leica SP5 confocal 

microscope was used with 63× objective and an additional 1.5× zoom. Z-stacks 

are 0.5 μ in thickness.

2. Open the Z-stacks in ImageJ software [43] and create maximum projections of 

Z-stacks.

3. Adjust image settings to using Image → Brightness Contrast option. It should be 

noted that once the brightness and contrast parameters are set, they should be 

applied to all the images in an experiment.

4. Set the measurement parameters by Analyze → Set measurements → Click on 

Area and Mean gray value.
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5. Select the “Free hand line” option and draw a line of a specific length (~10 μm in 

this experiment) along the membrane.

6. Select Analyze → Measure. This will provide the area and the mean color value.

7. Repeat steps 5 and 6 for at least additional three times on different areas of the 

Z-stack image to obtain a representative value. Repeat these steps as necessary to 

measure cytoplasmic and nuclear color values. It is important to keep the length 

of the line consistent between the Z-stacks.

Table 1, Figs. 3 and 4 show results obtained through the procedure described above. There 

are significant changes in the E-cadherin localization at 2.5% and 5% strain as measured 

from the obtained immunofluorescence images (Fig. 3). At both strains E-cadherin 

junctional localization was decreased, while the cytoplasmic localization was increased 

(Table 1) resulting in overall decreased junctional/cytoplasmic ratio (Fig. 4).

4 Notes

1. Calculations for Laminin dilution can be performed as follows: area of one strip 

is 22 cm2 (2 cm × 11 cm). Thus, 33 μg (22 cm2 × 1.5 μg/l cm2) of Laminin is 

required to coat one strip. Considering the original concentration of Laminin vial 

is 1.5 mg/mL and 1 mL of HBSS is required to cover the area of one strip, the 

dilution is 22 μL of Laminin in 1 mL of HBSS. (33 μg/1.5 mg/mL).

2. Generally, up to three 2 cm × 11 cm membranes can be placed inside one 150 

mm dish. If more membranes are placed, the area of the membranes that touches 

the bottom of dish will be decreased. This will negatively affect coating the 

membranes homogeneously.

3. Membranes should never dry and must be kept in medium or PBS at all times 

after fixation. Membranes should only be dried completely under the UV light, 

right before beginning of cell culture.

4. Sometimes, the diluted Laminin solution may leak out from the membranes into 

the cell culture dish bottom. This will negatively affect the membrane coating. In 

this situation, place the membranes in the bottom of the cell culture dish and 

cover the whole 150 mm plate with diluted Laminin for an even distribution. 

This will allow for a homogenous coating of the membranes.

5. We have identified Laminin as the substrate where the junctional localization of 

E-cadherin agrees with published work in well-differentiated Caco2 cells and 

tissues by us and others [29, 42, 44-46]. Nevertheless, other ECM proteins such 

as Collagens and Fibronectin can be used according to different cell types.

6. 10 × 106 [47] is half the cells at confluency of a 150 mm dish according to Fisher 

Scientific protocols. If cells are not attaching and growing properly, the seeding 

density can be changed accordingly. It is also important to note that seeding 

density varies depending on the cell line.

Daulagala et al. Page 7

Methods Mol Biol. Author manuscript; available in PMC 2022 January 01.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



7. Do not accidentally stretch the membranes while handling and placing inside and 

taking out of the apparatus.

8. Fixed membranes can be immersed in PBS, and stored at 4 °C until ready to be 

stained.

9. For multiple stains, membranes can be cut in 3–4 pieces accordingly, while they 

are still in PBS, before the blocking step.
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Fig. 1. 
The stretching device. (a) The fully assembled device is comprised of five parts: (b) two 

fasteners, the peg, the pulling clamp, and the main container. The distance from the starting 

point at the steady edge to the starting point at the pulling edge (L0) is 5 cm. The peg is 

marked with 0.1% strain intervals. The grooves in the pulling clamp ensures the membrane 

is intact and stable during the strain
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Fig. 2. 
Experimental platform stretching quantification. (a) Pencil shavings were scattered 

throughout the membranes and were put under 2.5% and 5% strain with 0% being the 

resting condition. Engineering strain (= stretch ratio – 1) along the axis of the stretching 

device (x/horizontal direction) was quantified by tracking fiduciary markers before and after 

2.5% (b), and 5% (c) strains, measuring the resulting displacements, and calculating strains 

accordingly. Each strain condition was repeated three times, and, in all cases, the resulting 

strain fields showed little to no spatial variation across x/horizontal and y/vertical positions. 

As expected, transverse strains (y/vertical direction) and shear strains were very small 

relative to axial strains (data not shown)
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Fig. 3. 
E-cadherin localization is affected by strain. Caco2 cells were fixed at different strains and 

were stained for E-cadherin by immunofluorescence. Each strain was repeated three times 

with a 0% control. Representative images shown here, where E-cadherin primarily localizes 

at areas of cell-cell contact at the 0% resting condition. However, at 2.5% (a) and 5% (b) 

strains, localization of E-cadherin at areas of cell-cell contact is significantly reduced, while 

the cytoplasmic localization is increased. At 5% strain, a perinuclear E-cadherin localization 

was also observed, which was included in the cytoplasmic fraction for the calculations
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Fig. 4. 
The ratio of junctional vs cytoplasmic E-cadherin localization is decreased upon application 

of strain in Caco2 cells. Graphical representation of the E-cadherin junctional and 

cytoplasmic immunofluorescence quantification of Caco2 cells under different conditions of 

strain presented in Table 1. Upon application of strain, the ratio of junctional to cytoplasmic 

localization of E-cadherin is significantly reduced (n = 3 representative fields; mean ± 

standard deviation; *P < 0.05, student’s t-test)

Daulagala et al. Page 14

Methods Mol Biol. Author manuscript; available in PMC 2022 January 01.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript

Daulagala et al. Page 15

Table 1

E-cadherin junctional and cytoplasmic immunofluorescence intensity units of Caco2 cells under different 

conditions of strain (n = 3 representative fields; mean ± standard deviation)

Strain (%) Junctional Cytoplasmic Junctional/cytoplasmic ratio

0 87.498 ± 12.634 21.935 ± 3.918 3.989 ± 0.715

2.5 31.350 ± 4.910 34.494 ± 7.632 0.934 ± 0.205

0 183.363 ± 5.634 57.979 ± 3.171 3.171 ± 0.245

5 70.472 ± 10.470 65.731 ± 11. 337 1.076 ± 0.029

Methods Mol Biol. Author manuscript; available in PMC 2022 January 01.


	Abstract
	Introduction
	Materials
	3D Printing
	Cell Culture
	Immunofluorescence

	Methods
	3D Design and Printing of the Stretching Apparatus
	Cell Culture
	Cell Stretching and Fixing Process
	Immunofluorescence Staining
	Imaging and Analysis

	Notes
	References
	Fig. 1
	Fig. 2
	Fig. 3
	Fig. 4
	Table 1

